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Introduction

Welcome!

Congratulations and thank you for purchasing WaveLab Elements 9, a 
basic editing and mastering environment that features a selection of 
quality tools to polish your audio material. For nearly a decade, 
WaveLab Elements has catered for the needs of producers, musicians, 
radio journalists and podcasters by including innovative features that 
are tailored to these areas of application.

Featuring the most comprehensive and accessible feature set in the 
long WaveLab Elements product history, WaveLab Elements 9 
reinvents audio refinement once again. Mastering and editing 
workflows become more creative than ever before. The new user 
interface of WaveLab Elements follows the popular ribbon concept, 
with multiple functions logically grouped under a ribbon tab. This way, 
WaveLab Elements' powerful editing and analysis functions are on 
hand at any time and are located right above the waveform.

One of the most creative features in WaveLab Elements 9 is MasterRig, 
a comprehensive mastering suite derived from the high-end mastering 
solution WaveLab Pro 9. MasterRig in WaveLab Elements 9 provides 
up to 5 plug-in slots that can be loaded with all-new professional 
effects such as a 4-band EQ, 2-band Compressor, 2-band Limiter, 
Saturator and Imager. In addition to the MasterRig, the new high-end 
Resampler improves quality when converting audio material to other 
sample rates. WaveLab Elements 9 is also prepared to connect to 
other Steinberg products such as Cubase and Nuendo by providing 
possibilities for a seamless exchange of audio material with these 
popular digital audio workstations. Of course, the program also 
contains a selection of renowned audio analyzing tools, allowing you to 
analyze and appraise your audio material with tools such as 
Spectroscope, 3D Spectrum view and WaveLab's Global Analysis.
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The Sonnox restoration suite consisting of DeBuzzer, DeNoiser and 
DeClicker allows for the removal of disturbing noises and to accurately 
and effectively restore impaired audio recordings.

Completed by a redesigned master channel, a new window-docking 
system as well as many further enhancements, WaveLab Elements 9 
raises the quality of your audio material dramatically and sets new 
standards for creative editing and mastering.

Don't forget to register at MySteinberg and get access to online 
support offers and additional exclusive services. We would also be 
delighted if we could welcome you as a member of the WaveLab 
community. The WaveLab online forum can be reached via 
www.steinberg.net/forum.

See you around!

Your Steinberg WaveLab Team

About the Documentation and the Help

• To open the help in the program, select Help > Contents.

• To open the Operation Manual in PDF format, select Help > PDF 
Documentation, or navigate to the installation folder. The PDF 
documents are located in the Documentation folder.

NOTE

To read the PDF documents, a suitable PDF reader application must be 
installed on your computer.
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Quick Start Guide

This is the document that you are reading. It covers the following areas 
without going into details:

• System requirements, installation procedure, and license 
activation.

• Setting up your system.

Operation Manual

The Operation Manual is the main WaveLab Elements reference 
documentation, with detailed descriptions of operations, parameters, 
functions, and techniques.

Key Commands

Many of the default key commands use modifier keys, some of which 
are different depending on the operating system.

For example, the default key command for Undo is [Ctrl]-[Z] on 
Windows and [Command]-[Z] on Mac OS X. When key commands 
with modifier keys are described in this manual, they are shown with the 
Windows modifier key first, in the following way:

• [Win modifier key]/[Mac modifier key]-[key]

EXAMPLE

[Ctrl]/[Command]-[Z] signifies: press [Ctrl] on Windows or [Command] 
on Mac OS X, then press [Z].

Similarly, [Alt]/[Option]-[X] signifies: press [Alt] on Windows or [Option] 
on Mac OS X, then press [X].
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Conventions

In our documentation, we use typographical elements and mark-ups to 
structure information.

How You Can Reach Us

On the Help menu, you find items linking to additional information.

The menu contains links to various Steinberg web pages. Selecting a 
menu item automatically launches your web browser and opens the 
page. On these pages, you can find support and compatibility 
information, answers to frequently asked questions, information about 
updates and other Steinberg products, etc. This requires a working 
Internet connection.
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System Requirements and 
Installation

System Requirements

Windows 7/8.x/10 — OS X 10.10/10.11

• Intel or AMD dual-core CPU

• 4 GB RAM

• 4 GB free HD space

• 1920 x 1080 display resolution (minimum: 1024 x 768)

• OS compatible audio hardware

• DVD ROM dual-layer drive

• Internet connection required for activation, account setup, and 
personal/product registration. Additional downloads may be 
required for the installation.

For recommended systems and support of future operating systems, 
please refer to the Support section on our website www.steinberg.net.
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Installing the Program

You have two possibilities to install your program, via the Start Center 
application or manually.

Launching Installation via the Start Center

From the Start Center application you can easily install your program 
and inform yourself about the package contents.

• For Steinberg software delivered with an installation medium, the 
Start Center launches automatically as soon as you insert the disc 
in your computer’s DVD drive, provided that autorun is activated.

• For Steinberg software downloaded from the Internet, the Start 
Center launches when you double-click the downloaded file.

PROCEDURE

1. In the Start Center, select your language.

2. Click Install.

3. Follow the instructions on screen.

Launching Installation Manually

If you do not want to install the program via the Start Center, you can 
install it manually.

• On Windows systems, double-click the file “Setup.exe” and follow 
the instructions on screen.

• On Mac OS X systems, double-click the file WaveLab Elements 
9.pkg and follow the instructions on screen.
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Activating Your License

IMPORTANT

The process for license activation is described in detail on the 
Steinberg web site. To open the corresponding page, follow the 
Activation & Registration link in the Start Center.

WaveLab Elements uses a software-based copy protection scheme. 
The so-called Soft-eLicenser is installed automatically with your version 
of WaveLab Elements. It can be accessed via the eLicenser Control 
Center application that is installed automatically with the product.

After installation, you need to activate your product. If you purchased 
WaveLab Elements in a shop, the product package contains the 
“Essential Product License Information” sheet which contains an 
activation code and describes the process in detail.

If you purchased the download version of WaveLab Elements, you 
receive an e-mail with the activation code and a description of the 
activation process.
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Registering Your Software

Register your product at the MySteinberg online customer portal. As a 
registered user, you are entitled to technical support, you gain access 
to exclusive offers such as software updates and upgrades, and more.

PREREQUISITE 

Make sure that you have a working Internet connection.

PROCEDURE

1. Start your software.

2. Select Help > Register Now.

An online registration form opens in your web browser.

3. Follow the instructions on screen to register at MySteinberg.

Hardware Installation

Installing the Audio Hardware and its Driver

PROCEDURE

1. Install the audio hardware and related equipment on the computer, 
as described in the hardware documentation.

2. Install the driver for the audio hardware.

A driver is a piece of software that allows a program to communicate with 
a certain piece of hardware. In this case, the driver allows WaveLab 
Elements to use the audio hardware. Depending on the operating system 
of your computer, there are different types of drivers that can be used.
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Dedicated ASIO Drivers

Professional audio hardware often comes with an ASIO driver written 
especially for the device. This allows for direct communication between 
WaveLab Elements and the audio hardware. As a result, the devices 
with specific ASIO drivers can provide lower latency (input-output 
delay), which is crucial when monitoring audio via WaveLab Elements 
or using VST instruments. The ASIO driver may also provide special 
support for multiple inputs and outputs, routing, synchronization, etc.

ASIO drivers are provided by the audio hardware manufacturers. Make 
sure to check the manufacturer’s web site for the latest driver versions.

IMPORTANT

If your audio hardware comes with a specific ASIO driver, we strongly 
recommend that you use this.

Mac OS X Drivers (Mac only)

If you are using a Macintosh computer, make sure that you are using the 
latest Mac OS X drivers for your audio hardware. Follow the instructions 
of the manufacturer to install the driver.

Audio Cards

WaveLab Elements works with any multimedia computer compatible 
audio card. However, the audio quality varies dramatically between 
cards.

For professional use of WaveLab Elements we recommend that you get 
a card with the highest possible specifications. However, if you use 
WaveLab Elements to edit files for use with other hardware, such as a 
hard disc based recording system using its own audio converters, any 

Quick_Start_Guide_EnDeFrItEsJa.book  Page 13  Tuesday, December 8, 2015  9:46 AM



System Requirements and Installation
Hardware Installation

14

E
N

G
LIS

H

loss in audio quality that you experience when listening to the files in 
WaveLab Elements, due to deficiencies in the audio card, does not 
affect the final audio files.

For professional use we recommend that you get a card capable of 
playing back files in 24-bit resolution.

Testing the Audio Hardware

To make sure that the audio device works as expected, perform the 
following tests.

• Use any software included with the hardware to make sure that you 
can record and play back audio without problems.

• If the hardware is accessed via a standard operating system driver, 
try playing back audio using the standard audio application of the 
computer, for example, Windows Media Player or Apple iTunes.

Installing a MIDI Interface or USB MIDI Keyboard

Although many USB MIDI keyboards and MIDI interfaces are plug&play 
devices, you may have to install a dedicated device driver. Follow the 
installation procedure described in the documentation that came with 
the device.

NOTE

You should also check the web site of the manufacturer for the latest 
driver updates.
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Setting up Your System

Selecting the Driver for Your Audio Device

PREREQUISITE 

Before you can set up the routing for your audio signals and start 
recording, you need to make sure that the correct ASIO driver is 
selected.

PROCEDURE

1. Select File > Preferences > VST Audio Connections.

2. On the Audio Device menu, select the driver that you want to use.

RELATED LINKS
“Hardware Installation” on page 12

Setting Up the VST Audio Connections

The VST Audio Connections tab allows you to set up the routing of 
input and output signals between WaveLab Elements and your audio 
hardware. Depending on the selected driver, the setting up process can 
be different.

PREREQUISITE 

Select the driver for your audio device.

PROCEDURE

1. Select File > Preferences > VST Audio Connections.

2. Select the Playback tab, and select and name the audio ports 
used for playback.
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3. Select the Recording tab, and select and name the audio ports 
used for recording and input monitoring.

4. If you are using an ASIO driver, select the ASIO Plug-ins tab, and 
select the audio ports used by the ASIO plug-ins.

5. Optional: If you are using an ASIO driver, click the Control Panel 
button and make additional settings.

6. Click OK.
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Einleitung

Willkommen!

Herzlichen Glückwunsch zum Kauf von WaveLab Elements 9 und 
vielen Dank, dass Sie sich für Steinbergs Einstiegslösung im Bereich 
Audioediting und Mastering entschieden haben. Durch eine sorgfältige 
Auswahl von Features und Funktionen, ist WaveLab Elements seit fast 
10 Jahren die erste Wahl für Hobby-Produzenten, Musiker, Journalisten 
und Podcaster.

WaveLab Elements 9 beinhaltet nicht nur das umfangreichste und 
zugleich intuitivste Feature-Set, das es für WaveLab Elements jemals 
gab. Es setzt einmal mehr Maßstäbe, wenn es um die Bearbeitung und 
Klangverbesserung Ihrer Audioaufnahmen geht. WaveLab Elements' 
neue Bedienoberfläche basiert auf dem populären "Ribbon" Konzept, 
das gleichartige Features zu einer Funktionsgruppe zusammenfasst. 
Auf diese Weise sind die Bearbeitungs- und Analysefunktionen in 
WaveLab Elements 9 jederzeit im Zugriff und befinden sich direkt 
oberhalb der Wellenform.

Das vielleicht kreativste Feature in WaveLab Elements 9 ist MasterRig. 
Diese Mastering Suite bietet eine Auswahl an Funktionen, die aus der 
High-End Masteringlösung WaveLab Pro 9 stammen. Dazu gehören 5 
Plug-In Slots, welche mit dem neuen 4-Band EQ, einem 2-Band 
Kompressor, sowie 2-Band Limiter, einem Saturator und einem Imager 
bestückt werden können. Darüber hinaus bietet WaveLab Elements 9 
einen neuen Resampler, der kompromisslose Qualität bei der 
Konvertierung von Audio Material in andere Sample Raten 
gewährleistet. WaveLab Elements 9 ist außerdem darauf vorbereitet, 
Audiodaten nahtlos und direkt mit anderen Steinberg Produkten wie 
Cubase und Nuendo auszutauschen. Im weiteren Funktionsumfang 
befindet sich außerdem eine grundlegende Auswahl an Analysetools, 
darunter Spektroskope, eine 3D Spektralansicht sowie Wavelab 
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Elements' beliebte Globalanalyse. Eine voll ausgestattete 
Restaurations-Suite, hergestellt von den Plug-In Spezialisten von 
Sonnox, ermöglicht das Entfernen ungewollter Störgeräusche wie 
Rauschen oder Klicken.

Das Feature Set von WaveLab Elements 9 wird abgerundet durch den 
neu gestalteten Master Kanalzug, ein intuitives Docking System sowie 
weitere Verbesserungen, welche die Qualität Ihres Audiomaterials und 
Ihre Kreativität dramatisch steigern.

Wenn Sie sich außerdem auf www.steinberg.de unter MySteinberg 
registrieren, erhalten Sie Zugriff auf Online Support Angebote und 
weitere exklusive Serviceleistungen. Darüber hinaus würden wir uns 
freuen, Sie als weiteres Mitglied unserer WaveLab-Community 
begrüßen zu dürfen. Das WaveLab Online-Forum ist unter 
www.steinberg.net/forum zu erreichen.

Wir freuen uns auf Sie!

Das Steinberg WaveLab Team

Die Dokumentation und die Hilfe

• Um die Hilfe im Programm zu öffnen, klicken Sie auf Hilfe > 
Inhalte.

• Um das Benutzerhandbuch im PDF-Format zu öffnen, wählen Sie 
Hilfe > PDF-Dokumentation oder öffnen Sie den 
Installationsordner. Die PDF-Dokumente befinden sich im Ordner 
Documentation.

HINWEIS

Damit Sie die PDF-Dokumente lesen können, muss ein PDF-Reader auf 
Ihrem Computer installiert sein.
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Schnelleinstieg

Das ist das Dokument, das Sie vor sich haben. Es deckt die folgenden 
Bereiche ab, ohne jedoch zu sehr ins Detail zu gehen:

• Systemvoraussetzungen, Installationsprozess und 
Lizenzaktivierung.

• System einrichten.

Benutzerhandbuch

Das Benutzerhandbuch ist für WaveLab Elements die wichtigste 
Informationsquelle mit ausführlichen Beschreibungen aller Parameter, 
Funktionen und Arbeitsweisen.

Tastaturbefehle

Bei vielen Standardtastaturbefehlen werden Sondertasten verwendet, 
von denen einige je nach Betriebssystem abweichen können.

Der Standardtastaturbefehl für Rückgängig ist z. B. unter Windows 
[Strg]-[Z] und unter Mac OS X [Befehlstaste]-[Z]. Wenn in diesem 
Handbuch Tastaturbefehle mit Sondertasten beschrieben werden, 
stehen die Windows-Sondertasten an erster Stelle:

• [Windows-Sondertaste]/[Mac-Sondertaste]-[Taste]

[Strg]-Taste/[Befehlstaste]-[Z] bedeutet: Drücken Sie [Strg] unter 
Windows oder [Befehlstaste] unter Mac OS X, und drücken Sie dann 
[Z].

Entsprechend bedeutet [Alt]-Taste/[Wahltaste]-[X]: Drücken Sie [Alt] 
unter Windows oder [Wahltaste] unter Mac OS X, und drücken Sie 
dann [X].
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Konventionen

In unserer Dokumentation verwenden wir typografische Elemente und 
Kennzeichnungen, um Informationen zu strukturieren.

So können Sie uns erreichen

Im Hilfe-Menü finden Sie Verweise auf zusätzliche Informationen.

Das Menü enthält Links zu diversen Steinberg-Seiten im Internet. Beim 
Auswählen einer Menüoption wird automatisch Ihr Web-Browser 
gestartet und die entsprechende Seite geöffnet. Hier erhalten Sie 
technische Unterstützung und Informationen zur Kompatibilität, 
Antworten auf häufig gestellte Fragen, Informationen über Updates und 
andere Steinberg-Produkte usw. Dazu benötigen Sie eine aktive 
Internetverbindung.
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Systemanforderungen und 
Installation

Systemanforderungen

Windows 7/8.x/10 — OS X 10.10/10.11

• Dual-Core-Prozessor von Intel oder AMD

• 4 GB RAM

• 4 GB freier Speicherplatz

• Bildschirmauflösung von 1920 x 1080 Pixeln (mindestens 1024 x 
768)

• Betriebssystemkompatible Audio-Hardware

• DVD-ROM Double-Layer-Laufwerk

• Internetverbindung für die Aktivierung und Einrichtung eines 
Benutzerkontos sowie die persönliche und die 
Produktregistrierung.. Die Installation kann zusätzliche Downloads 
erfordern.

Informationen zu den empfohlenen Systemen und der Unterstützung 
zukünftiger Betriebssysteme finden Sie im Support-Bereich unter 
www.steinberg.net.
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Programminstallation

Sie können das Programm über das Start Center oder manuell 
installieren.

Installation über das Start Center starten

Über das Start Center können Sie auf sehr einfache Weise das 
Programm installieren und sich über den Packungsinhalt informieren.

• Bei Steinberg-Software, die mit einem Installationsmedium 
ausgeliefert wurde, wird das Start Center beim Einlegen des 
Mediums automatisch gestartet, vorausgesetzt, dass Autorun 
aktiviert ist.

• Bei Steinberg-Software, die aus dem Internet heruntergeladen 
wurde, wird das Start Center gestartet, wenn Sie auf die 
heruntergeladene Datei doppelklicken.

VORGEHENSWEISE

1. Wählen Sie im Start Center Ihre Sprache aus.

2. Klicken Sie auf Installation.

3. Befolgen Sie die Anweisungen auf dem Bildschirm.

Installation manuell starten

Wenn Sie das Programm nicht über das Start Center installieren 
möchten, können Sie es auch manuell installieren.

• Wenn Sie auf einem Windows-System arbeiten, doppelklicken Sie 
auf die Datei »Setup.exe« und befolgen Sie die Anweisungen auf 
dem Bildschirm.
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• Wenn Sie auf einem Mac OS X System arbeiten, doppelklicken 
Sie auf die Datei WaveLab Elements 9.pkg und befolgen Sie 
die Anweisungen auf dem Bildschirm.

Lizenzaktivierung

HINWEIS

Der Prozess zur Lizenzaktivierung wird ausführlich auf der 
Steinberg-Website beschrieben. Um die entsprechende Seite zu 
öffnen, klicken Sie auf den Link »Aktivierung und Registrierung« im Start 
Center.

WaveLab Elements verwendet einen software-basierten 
Kopierschutzmechanismus. Der sogenannte Soft-eLicenser wird 
automatisch mit WaveLab Elements installiert. Sie können auf den 
eLicenser über die Anwendung »eLicenser Control Center« zugreifen, 
die automatisch mit dem Produkt installiert wird.

Nach der Installation müssen Sie Ihr Produkt aktivieren. Wenn Sie 
WaveLab in einem Geschäft erworben haben, enthält der Lieferumfang 
das Beiblatt »Essential Product License Information« mit einem 
Aktivierungscode und ausführlicher Beschreibung des 
Aktivierungsprozesses.

Wenn Sie die Download-Version von WaveLab erworben haben, 
erhalten Sie eine E-Mail mit dem Aktivierungscode und einer 
Beschreibung des Aktivierungsprozesses.
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Software-Registrierung

Registrieren Sie Ihre Software beim Online-Kundenportal MySteinberg. 
Als registrierter Benutzer haben Sie Anspruch auf technischen 
Support, erhalten exklusive Angebote wie Updates und Upgrades und 
vieles mehr.

VORAUSSETZUNGEN 

Beachten Sie, dass Sie hierzu eine aktive Internetverbindung 
benötigen.

VORGEHENSWEISE

1. Starten Sie Ihre Software.

2. Wählen Sie Hilfe > Jetzt registrieren.

Ein Online-Registrierungsformular wird in Ihrem Web-Browser geöffnet.

3. Befolgen Sie die Anweisungen auf dem Bildschirm, um sich bei 
MySteinberg zu registrieren.
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Hardware-Installation

Audio-Hardware und Treiber installieren

VORGEHENSWEISE

1. Installieren Sie die Audiokarte und die dazugehörige Software wie 
in der Bedienungsanleitung für die Karte beschrieben.

2. Installieren Sie den Treiber für die Audio-Hardware.

Mit Hilfe von Treiber-Software kann das Programm mit einer bestimmten 
Hardware kommunizieren. In diesem Fall ermöglicht der Treiber 
WaveLab Elements den Zugriff auf die Audio-Hardware. Je nach 
Betriebssystem Ihres Computers können Sie unterschiedliche 
Treiberarten verwenden.

Spezielle ASIO-Treiber

Professionelle Audio-Hardware wird oft mit einem ASIO-Treiber 
geliefert, der speziell für diese Hardware ausgelegt ist. So kann 
WaveLab Elements direkt mit der Audio-Hardware kommunizieren. 
Daher kann Audio-Hardware mit speziellen ASIO-Treibern die 
Latenzzeiten (Eingangs-/Ausgangsverzögerung) verkürzen, was beim 
Mithören von Audiomaterial über WaveLab Elements oder beim 
Verwenden von VST-Instrumenten entscheidend ist. Der ASIO-Treiber 
bietet eventuell auch spezielle Unterstützung für Karten mit mehreren 
Ein- und Ausgängen, Routing, Synchronisation usw.

ASIO-Treiber werden vom Hersteller der Audio-Hardware geliefert. 
Informieren Sie sich auf der Website des Herstellers über die neuesten 
Treiberversionen.
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HINWEIS

Wenn es für Ihre Audiokarte einen eigenen ASIO-Treiber gibt, sollten 
Sie diesen verwenden.

Mac OS X Treiber (nur Mac)

Wenn Sie einen Macintosh-Computer verwenden, stellen Sie sicher, 
dass Sie den aktuellen Mac OS X Treiber für Ihre Audio-Hardware 
verwenden. Beachten Sie die Anleitungen des Herstellers zur 
Treiber-Installation.

Audiokarten

WaveLab Elements unterstützt jede Audiokarte, die mit einem 
Multimedia-Computer kompatibel ist. Die Audioqualität der Karten kann 
jedoch stark variieren.

Wenn Sie WaveLab Elements professionell einsetzen, empfehlen wir, 
eine möglichst leistungsfähige Karte zu verwenden. Wenn Sie jedoch 
WaveLab Elements zum Bearbeiten von Dateien für den Einsatz mit 
anderer Hardware verwenden möchten – z. B. mit einem 
festplattengestützten Aufnahmesystem, das eigene Audiokonverter 
einsetzt – hat es keine Auswirkungen auf die finalen Audiodateien, 
wenn Sie beim Hören der Dateien in WaveLab Elements Verluste in der 
Audioqualität wahrnehmen, die sich aufgrund von vorhandenen 
Defiziten Ihrer Audiokarte ergeben.

Für den professionellen Einsatz empfehlen wir eine Karte, die Dateien 
in 24-Bit-Auflösung wiedergibt.
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Audio-Hardware überprüfen

Führen Sie folgende Tests durch, um sicherzustellen, dass Ihre 
Audio-Hardware wie gewünscht funktioniert.

• Verwenden Sie die mit der Audio-Hardware gelieferte Software, 
um zu überprüfen, ob Sie problemlos Audiomaterial aufnehmen 
und wiedergeben können.

• Wenn Sie mit einem Betriebssystem-Treiber auf die Karte 
zugreifen, geben Sie Audiomaterial mit der 
Standard-Audioanwendung wieder (z. B. Windows Media Player 
oder Apple iTunes).

MIDI-Schnittstelle oder USB-MIDI-Keyboard 
installieren

Auch wenn es sich bei vielen USB-MIDI-Keyboards und 
MIDI-Schnittstellen um Plug&Play-Geräte handelt, müssen Sie 
eventuell einen speziellen Gerätetreiber installieren. Befolgen Sie die 
Installationsanweisung in der Dokumentation zu Ihrem Gerät.

HINWEIS

Informieren Sie sich auf der Website des Herstellers über die neuesten 
Treiberversionen.
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System einrichten

Treiber für Ihr Audiogerät auswählen

VORAUSSETZUNGEN 

Bevor Sie das Routing für Ihre Audiosignale festlegen und mit der 
Aufnahme beginnen, sollten Sie sicherstellen, dass der richtige 
ASIO-Treiber ausgewählt ist.

VORGEHENSWEISE

1. Wählen Sie Datei > Voreinstellungen > 
VST-Audio-Verbindungen.

2. Wählen Sie unter Audiogerät den Treiber aus, den Sie verwenden 
möchten.

WEITERFÜHRENDE LINKS
“Hardware-Installation” auf Seite 28
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VST-Audio-Verbindungen einrichten

Auf der Registerkarte VST-Audio-Verbindungen können Sie 
Einstellungen zum Weiterleiten von Audiosignalen zwischen 
WaveLab Elements und Ihrer Audio-Hardware vornehmen. Je nach 
ausgewähltem Treiber kann der Einrichtungsprozess variieren.

VORAUSSETZUNGEN 

Wählen Sie den Treiber für Ihr Audiogerät aus.

VORGEHENSWEISE

1. Wählen Sie Datei > Voreinstellungen > 
VST-Audio-Verbindungen.

2. Wählen Sie auf der Wiedergabe-Registerkarte die Audio-Ports für 
die Wiedergabe und vergeben Sie gegebenenfalls neue Namen.

3. Wählen Sie auf der Aufnahme-Registerkarte die Audio-Ports für 
Aufnahme und Monitoring und vergeben Sie gegebenenfalls neue 
Namen.

4. Wenn Sie einen ASIO-Treiber verwenden, wählen Sie auf der 
ASIO-PlugIns-Registerkarte die Audio-Ports aus, die von den 
ASIO-PlugIns verwendet werden.

5. Optional: Wenn Sie einen ASIO-Treiber verwenden, klicken Sie 
auf den Einstellungen-Schalter und nehmen Sie weitere 
Einstellungen vor.

6. Klicken Sie auf OK.
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Ce document PDF a été amélioré pour être plus facile d’accès aux 
personnes malvoyantes. En raison du grand nombre d’images qu’il 
contient et de leur complexité, veuillez noter qu’il n’a pas été possible 
d’intégrer de descriptions textuelles des images.

Les informations contenues dans ce document sont sujettes à 
modification sans préavis et n’engagent aucunement la responsabilité 
de Steinberg Media Technologies GmbH. Le logiciel décrit dans ce 
document fait l’objet d’un Accord de Licence et ne peut être copié sur 
un autre support sauf si cela est autorisé spécifiquement par l’Accord 
de Licence. Aucune partie de cette publication ne peut être copiée, 
reproduite ni même transmise ou enregistrée, sans la permission écrite 
préalable de Steinberg Media Technologies GmbH. Les détenteurs 
enregistrés de la licence du produit décrit ci-après sont autorisés à 
imprimer une copie du présent document pour leur usage personnel.

Tous les noms de produits et de sociétés sont des marques déposées 
™ ou ® de leurs propriétaires respectifs. Pour de plus amples 
informations, rendez-vous sur le site www.steinberg.net/trademarks.

© Steinberg Media Technologies GmbH, 2016.

Tous droits réservés.
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Introduction

Bienvenue !

Félicitations et merci d’avoir acheté WaveLab Elements 9, un 
environnement qui vous donne accès aux principaux outils d’édition et 
de mastering nécessaires pour peaufiner des signaux audio. Depuis 
près d'une décennie, WaveLab Elements répond aux besoins des 
producteurs, musiciens, journalistes radio et balladodiffuseurs en leur 
apportant des fonctions innovantes spécialement conçues pour ces 
applications.

Doté des fonctions les plus complètes et accessibles de la longue série 
de versions du logiciel, WaveLab Elements 9 réinvente, une fois 
encore, la perfection audio. Le mastering et l'édition n'ont jamais permis 
autant d'innovations. La nouvelle interface de WaveLab Elements utilise 
le nouveau concept de ruban, et les différentes fonctionnalités y sont 
regroupées par thèmes dans des onglets. Ainsi, les puissantes 
fonctions d'édition et d'analyse de WaveLab Elements restent 
accessibles en permanence au-dessus du graphique de la forme 
d'onde.

L'une des nouveautés les plus intéressantes de WaveLab Elements 9 
est MasterRig, une suite de mastering complète extraite de la solution 
de mastering de pointe WaveLab Pro 9. La suite MasterRig de 
WaveLab Elements 9 vous permet de charger simultanément jusqu'à 
cinq plug-ins d'effets professionnels tout nouveaux, notamment un 
égaliseur à quatre bandes, un compresseur à deux bandes, un limiteur 
à deux bandes, une saturation et un imageur. En parallèle de MasterRig, 
le nouveau Resampler améliore la qualité audio des sons 
rééchantillonnés en cas de conversion à partir de fréquences 
d’échantillonnage différentes. WaveLab Elements 9 a également été 
conçu pour être combiné à d'autres produits Steinberg tels que 
Cubase et Nuendo, et il intègre des fonctionnalités permettant un 
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échange optimal de données audio avec ces célèbres stations de 
travail. Le programme est bien sûr doté de tout un éventail d’outils 
réputés d’analyse et d’évaluation des données audio, tels que le 
Spectroscope, la vue 3D Spectrum et la fonction Analyse Globale.

La suite de restauration Sonnox, qui comprend les plug-ins DeBuzzer, 
DeNoiser et DeClicker, permet d'éliminer les parasites gênants et de 
restaurer efficacement et fidèlement les enregistrements audio 
endommagés.

Grâce à son canal maître entièrement revu, son nouveau système 
d'ancrage des fenêtres et de nombreuses autres nouveautés, 
WaveLab Elements 9 améliore radicalement la qualité des données 
audio et offre des fonctionnalités innovantes pour l'édition et le 
mastering.

N’oubliez pas de vous enregistrer sur MySteinberg afin d’accéder à des 
offres de support en ligne et à des services supplémentaires exclusifs. 
Par ailleurs, nous serions heureux de vous accueillir dans la 
communauté WaveLab. Vous pouvez accéder au forum en ligne de 
WaveLab via www.steinberg.net/forum.

À bientôt !

Votre équipe Steinberg WaveLab

À propos de la documentation et de l’aide

• Pour accéder à l’aide à partir du programme, sélectionnez Aide > 
Table des matières.

• Pour ouvrir le Mode d'emploi au format PDF, sélectionnez Aide > 
Documentation PDF, ou accédez au dossier d'installation. Les 
documents PDF se trouvent dans le dossier Documentation.
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 À NOTER

Pour lire les documents PDF il faut qu’une application de lecture de 
documents PDF soit installée sur votre ordinateur.

Guide Rapide

Il s'agit du document que vous lisez actuellement. Sans trop entrer dans 
les détails, il couvre les domaines suivants :

• Configuration minimale, procédure d’installation et activation de la 
licence.

• Configuration de votre système.

Mode d'emploi

Le Mode d'emploi est le principal document de référence de 
WaveLab Elements, il décrit en détail les opérations, les paramètres, 
les fonctions et les techniques auxquels le logiciel vous donne accès.

Raccourcis clavier

De nombreux raccourcis clavier par défaut utilisent des touches mortes 
dont certaines changent en fonction du système d’exploitation utilisé.

Par exemple, le raccourci clavier par défaut pour Annuler est [Ctrl]-[Z] 
sous Windows et [Commande]-[Z] sous Mac OS X. Lorsque des 
raccourcis clavier employant des touches mortes sont mentionnés 
dans ce manuel, ils indiquent d’abord la touche morte Windows, selon 
la formule suivante :

• [Touche morte Win]/[Touche morte Mac]-[Touche]

[Ctrl]/[Commande]-[Z] signifie : Appuyez sur [Ctrl] sous Windows ou 
sur [Commande] sous Mac OS X, puis appuyez sur [Z].
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De même, [Alt]/[Option]-[X] signifie : Appuyez sur [Alt] sous Windows 
ou sur [Option] sous Mac OS X, puis appuyez sur [X].

Conventions

Nous avons utilisé des éléments typographiques et des balises pour 
structurer les informations contenues dans cette documentation.

Comment nous contacter

Les options proposées dans le menu Aide vous permettent d'accéder 
à des rubriques d'information supplémentaires.

Ce menu contient des liens vers diverses pages du site Web de 
Steinberg. Quand vous sélectionnez une option du menu, votre 
navigateur Internet s’ouvre automatiquement à la page correspondante. 
Dans ces pages, vous trouverez de l'assistance technique, des 
informations sur la compatibilité, des réponses aux questions 
fréquemment posées, des informations sur les mises à jour et les autres 
produits de Steinberg, etc. Pour y accéder, vous devez disposer d'une 
connexion Internet.
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Système requis et installation

Configuration minimale

Windows 7/8.x/10 — OS X 10.10/10.11

• Processeur double-cœur Intel ou AMD

• 4 Go de RAM

• 4 Go d'espace disque libre

• Résolution d'affichage de 1920 x 1080 (minimum : 1024 x 768)

• Interface audio compatible avec le système d'exploitation

• Lecteur DVD ROM double couche

• Connexion Internet pour l’activation, la configuration du compte et 
l’enregistrement personnel/du produit. Il peut s'avérer nécessaire 
de télécharger des fichiers supplémentaires pour l'installation.

Pour en savoir plus sur les systèmes recommandés et la prise en 
charge des prochains systèmes d'exploitation, veuillez vous référer à la 
section Support de notre site www.steinberg.net.
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Installation du programme

Vous avez deux possibilités pour l’installation du programme : via 
l’application Start Center ou manuellement.

Lancement de l’installation via Start Center

À partir de l’application Start Center, vous pouvez facilement installer 
votre programme et découvrir le contenu de la boîte du produit.

• Si votre logiciel Steinberg vous a été fourni avec un support 
d’installation, Start Center se lance automatiquement quand vous 
insérez ce disque dans le lecteur DVD de votre ordinateur, à 
condition que la fonction autorun ait été activée.

• Si vous avez téléchargé votre logiciel Steinberg depuis Internet, 
Start Center se lance quand vous double-cliquez sur le fichier 
téléchargé.

PROCÉDER AINSI

1. Dans Start Center, sélectionnez votre langue.

2. Cliquez sur Installer.

3. Suivez les instructions à l’écran.

Lancement de l’installation manuellement

Si vous ne souhaitez pas installer le programme via Start Center, vous 
pouvez l’installer manuellement.

• Sur les systèmes Windows, double-cliquez sur le fichier 
« Setup.exe » et suivez les instructions à l’écran.
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• Sur les systèmes Mac OS X, double-cliquez sur le fichier 
WaveLab Elements 9.pkg et suivez les instructions à l’écran.

Activation de votre licence

IMPORTANT

Le processus d’activation de la licence est décrit en détail sur le site 
Web de Steinberg. Pour ouvrir la page correspondante, cliquez sur le 
lien Activation & Registration dans Start Center.

WaveLab Elements utilise un système logiciel de protection contre la 
copie. Appelé Soft-eLicenser, il s’installe automatiquement quand vous 
installez WaveLab Elements. Vous pouvez y accéder via l’application 
eLicenser Control Center, laquelle s’installe également avec le produit.

Suite à l’installation, il vous faut activer votre produit. Si vous avez 
acheté WaveLab Elements en magasin, la boîte du produit contient la 
feuille « Essential Product License Information » (informations 
essentielles sur la licence du produit). Vous pourrez y trouver un code 
d’activation et des informations détaillées sur le processus.

Si vous avez acheté la version téléchargeable de WaveLab Elements, 
vous recevrez un courriel contenant le code d’activation et une 
description du processus d’activation.
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Enregistrement de votre logiciel

Enregistrez votre produit sur le portail client en ligne MySteinberg. En 
tant qu’utilisateur enregistré, vous avez accès à un service d’assistance 
technique, à des offres exclusives telles que des mises à niveau ou des 
mises à jour logicielles, et à bien plus encore.

CONDITION PRÉALABLE 

Assurez-vous de bien être connecté à Internet.

PROCÉDER AINSI

1. Démarrez votre logiciel.

2. Sélectionnez Aide  > Enregistrez-vous maintenant.

Un formulaire d’enregistrement en ligne s’ouvre dans votre navigateur 
Web.

3. Suivez les instructions à l’écran pour enregistrer votre produit sur 
MySteinberg.

Installation du matériel

Installation de l’interface audio et de son pilote

PROCÉDER AINSI

1. Installez l’interface audio et ses accessoires sur l’ordinateur en 
procédant comme indiqué dans la documentation du matériel.

2. Installez le pilote de l’interface audio.

Un pilote est un élément logiciel permettant au programme de 
communiquer avec certains matériels. Ici, le pilote permet à 
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WaveLab Elements d’utiliser la carte son. Selon le système d’exploitation 
de votre ordinateur, il est possible que vous ayez le choix entre plusieurs 
types de pilotes.

Pilotes ASIO dédiés

Les interfaces audio professionnelles sont souvent livrées avec un 
pilote ASIO spécialement conçu pour ce matériel. Ce pilote assure la 
communication directe entre WaveLab Elements et l’interface audio. 
Par conséquent, les équipements dotés de pilotes ASIO spécifiques 
bénéficient d’une latence (retard entre entrée et sortie) moins élevée, 
ce qui est essentiel pour pouvoir écouter des signaux audio via 
WaveLab Elements ou utiliser des instruments VST. D’autre part, le 
pilote ASIO prend parfois en charge les entrées et sorties multiples, le 
routage, la synchronisation, etc.

Les pilotes ASIO sont fournis par le fabricant de l’interface audio. 
Vérifiez sur le site Web du fabricant que vous possédez bien la dernière 
version du pilote.

IMPORTANT

Si votre interface audio est livrée avec un pilote ASIO spécifique, nous 
vous recommandons fortement d’utiliser celui-ci.

Pilotes Mac OS X (Mac uniquement)

Si vous utilisez un ordinateur Macintosh, veillez à installer les tout 
derniers pilotes Mac OS X pour votre interface audio. Suivez les 
instructions d’installation fournies par le fabricant pour installer le pilote.
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Cartes son

WaveLab Elements fonctionne avec toutes les cartes son multimédia 
compatibles. Néanmoins, la qualité audio varie considérablement d’une 
carte à l’autre.

Pour une utilisation professionnelle de WaveLab Elements, nous vous 
recommandons de vous procurer la carte la plus performante possible. 
Cependant, si vous utilisez WaveLab Elements pour éditer des fichiers 
destinés à être utilisés avec d'autres équipements (un système 
d’enregistrement sur disque dur doté de ses propres convertisseurs 
audio, par exemple) et que vous constatez une perte de qualité due à la 
faiblesse de la carte son quand vous écoutez ces fichiers dans 
WaveLab Elements, cette perte n’aura aucun incidence sur la qualité 
des fichiers audio finaux.

Pour une utilisation dans un contexte professionnel, nous vous 
recommandons de vous munir d’une carte capable de prendre en 
charge des fichiers d’une résolution de 24 bits.

Test de l’interface audio

Pour vérifier si votre interface audio fonctionne correctement, effectuez 
les tests suivants.

• Utilisez l’un des logiciels fournis avec votre matériel pour vous 
assurer que la lecture et l’enregistrement audio fonctionnent sans 
problèmes.

• Si l’accès à l’interface se fait via un pilote standard du système 
d’exploitation, essayez de lire les données audio en utilisant 
l’application audio standard du système (par ex. Windows Media 
Player ou Apple iTunes).
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Installation d’une interface MIDI ou d’un clavier 
MIDI USB

Bien que la plupart des claviers MIDI USB et des interfaces MIDI 
fonctionnent en plug&play, vous devrez peut-être installer un pilote 
dédié à votre périphérique. Veillez alors à bien suivre la procédure 
d’installation décrite dans la documentation fournie avec le 
périphérique.

 À NOTER

Veuillez aussi vérifier sur le site Web du fabricant que vous disposez 
bien de la dernière version du pilote.

Configuration de votre système

Sélection du pilote de votre interface audio

CONDITION PRÉALABLE 

Avant de configurer le routage de vos signaux audio et de commencer 
à enregistrer, il vous faut vérifier si le pilote ASIO approprié est bien 
sélectionné.

PROCÉDER AINSI

1. Sélectionnez Fichier > Préférences > Connexions audio VST.

2. Dans le menu Dispositif Audio, sélectionnez le pilote que vous 
souhaitez utiliser.

LIENS ASSOCIÉS
“Installation du matériel” à la page 43
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Configuration des connexions audio VST

L'onglet Connexions Audio VST vous permet de configurer le routage 
des signaux d’entrée et de sortie entre WaveLab Elements et votre 
interface audio. Selon le pilote que vous avez sélectionné, il se peut que 
le processus de configuration soit différent.

CONDITION PRÉALABLE 

Sélectionnez le pilote de votre interface audio.

PROCÉDER AINSI

1. Sélectionnez Fichier > Préférences > Connexions Audio VST.

2. Sélectionnez l’onglet Lecture, puis sélectionnez et nommez les 
ports audio utilisés pour la lecture.

3. Sélectionnez l’onglet Enregistrement, puis sélectionnez et 
nommez les ports audio utilisés pour l’enregistrement et le 
monitoring d’entrée.

4. Si vous utilisez un pilote ASIO, sélectionnez l’onglet Plug-ins 
ASIO, puis sélectionnez les ports audio utilisés par les plug-ins 
ASIO.

5. Facultatif : si vous utilisez un pilote ASIO, cliquez sur le bouton 
Panneau de contrôle et configurez les autres paramètres.

6. Cliquez sur OK.
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Le informazioni contenute in questo manuale sono soggette a variazioni 
senza preavviso e non rappresentano un obbligo da parte di Steinberg 
Media Technologies GmbH. Il software descritto in questo manuale è 
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Introduzione

Benvenuti!

Congratulazioni e grazie per aver acquistato WaveLab Elements 9, un 
ambiente di base per l’editing audio e il mastering, caratterizzato da una 
ricca selezione di strumenti di altissimo livello per migliorare la qualità e 
la resa del vostro materiale audio. Per quasi un decennio, WaveLab 
Elements ha saputo rispondere puntualmente alle esigenze di 
produttori, musicisti, giornalisti radiofonici e podcaster, grazie a una 
ricca selezione di funzionalità progettate nello specifico per queste aree 
di applicazione.

Con la dotazione più completa di sempre di funzioni di altissima qualità 
e di semplice utilizzo, WaveLab Elements 9 riesce nel difficile scopo di 
reinventare ancora una volta lo standard dell'audio refinement. Il flusso 
di lavoro dei processi di mastering e di editing raggiunge un livello di 
creatività mai visto prima. La nuova interfaccia utente di WaveLab 
Elements segue il popolare concetto di multifunzionalità, in cui più 
funzioni sono raggruppate in senso logico in un'unica scheda 
multifunzione. In tal modo, le potenti funzioni di editing e analisi di 
WaveLab Elements risultano immediatamente disponibili in qualsiasi 
momento e facilmente accessibili direttamente sopra la forma d'onda.

Una delle funzionalità più creative di WaveLab Elements 9 è 
rappresentata da MasterRig, una completa e potente suite di mastering 
derivata direttamente da WaveLab Pro 9, l'avanzatissima soluzione di 
mastering top level di Steinberg. La versione di MasterRig disponibile 
in WaveLab Elements 9 è dotata di 5 slot per i plug-in in cui è possibile 
caricare dei nuovissimi effetti di livello professionale, tra cui un 
equalizzatore a 4 bande, un Compressor a 2 bande, un Limiter a 2 
bande, un Saturator e un Imager. In aggiunta a MasterRig, il nuovo 
avanzatissimo plug-in Resampler offre la possibilità di migliorare la 
qualità del materiale audio durante la conversione verso altre frequenze 
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di campionamento. WaveLab Elements 9 è inoltre predisposto per la 
connessione con altri prodotti di Steinberg come Cubase e Nuendo, 
garantendo uno scambio senza interruzioni di materiale audio con 
queste celeberrime workstation audio digitali. Il programma contiene 
inoltre una ricca selezione di rinomati strumenti di analisi audio, tra cui 
lo Spettroscopio, la vista delle frequenze in 3D e lo strumento di analisi 
globale di WaveLab, che consentono di analizzare e valutare con 
precisione qualsiasi tipo di materiale audio.

La suite di restauro audio di Sonnox, costituita dai plug-in DeBuzzer, 
DeNoiser e DeClicker, consente di rimuovere i rumori di disturbo e di 
ripristinare in maniera efficace e precisa le registrazioni audio 
danneggiate.

Grazie infine alla presenza di un canale master totalmente riprogettato, 
a un nuovo sistema di ancoraggio delle finestre, oltre a molte altre 
migliorie aggiuntive, WaveLab Elements 9 è in grado di incrementare 
drasticamente la qualità di qualsiasi tipo di materiale audio e di stabilire 
nuovi standard per l'editing creativo e il mastering.

Non dimenticate di registravi su MySteinberg e ottenere così l’accesso 
al servizio di supporto online e a tutti i nostri esclusivi servizi aggiuntivi. 
Saremmo inoltre onorati di avervi come nuovi membri della community 
di WaveLab. Il forum online di WaveLab è raggiungibile all’indirizzo web 
www.steinberg.net/forum.

A presto!

Il vostro Team WaveLab di Steinberg
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Informazioni sulla documentazione e sulla 
sezione di aiuto

• Per aprire la sezione di aiuto nel programma, selezionare Aiuto > 
Contenuti.

• Per aprire il Manuale Operativo in formato PDF, selezionare Aiuto 
> Documentazione PDF o raggiungere la cartella di installazione. 
I documenti in PDF si trovano nella cartella Documentazione.

NOTA

Per leggere i documenti in PDF è necessario che sul computer sia 
installata un’applicazione di lettura di questo tipo di file.

Guida Rapida

Si tratta del documento che state leggendo. Sono trattati i seguenti 
argomenti, senza scendere nei dettagli:

• Requisiti di sistema, procedure di installazione e attivazione della 
licenza.

• Configurazione del sistema.

Manuale Operativo

Il Manuale Operativo rappresenta il documento di riferimento principale 
di WaveLab Elements e contiene le descrizioni dettagliate delle 
operazioni eseguibili nel programma, dei parametri, delle funzioni e delle 
tecniche di utilizzo.
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Comandi da tastiera

Molti dei comandi da tastiera di default fanno uso dei cosiddetti tasti 
modificatori, alcuni dei quali differiscono a seconda del sistema 
operativo utilizzato.

Ad esempio, il comando rapido di default per la funzione Annulla è 
[Ctrl]-[Z] su Windows e [Comando]-[Z] su Mac OS X. Quando nel 
presente manuale vengono descritti dei comandi da tastiera con i tasti 
modificatori, questi vengono visualizzati con prima i tasti modificatori 
per Windows, nella maniera seguente:

• [Tasto modificatore per Windows]/[Tasto modificatore per 
Mac]-[tasto]

[Ctrl]/[Command]-[Z] significa: premere [Ctrl] su Windows o 
[Command] su Mac OS X, quindi premere [Z].

Analogamente, [Alt]/[Option]-[X] significa: premere [Alt] su Windows o 
[Option] su OS X, quindi premere [X].

Convenzioni

Nella documentazione fornita si fa ampio utilizzo degli elementi 
tipografici e dei mark-up per strutturare meglio e rendere più accessibili 
le informazioni.
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Come contattare Steinberg

Nel menu Aiuto si trovano diversi elementi di collegamento a una serie 
di informazioni aggiuntive.

Questo menu contiene dei link a diverse pagine del sito web di 
Steinberg. La selezione di una voce del menu lancia automaticamente 
il browser web e apre la rispettiva pagina. In queste pagine sono 
disponibili varie informazioni di supporto e compatibilità, risposte a 
FAQs (frequently asked questions), informazioni riguardo ad 
aggiornamenti e ad altri prodotti di Steinberg, ecc. Per poter utilizzare 
questa funzione è necessario disporre di una connessione internet 
funzionante.
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Requisiti di sistema e 
installazione

Requisiti di sistema

Windows 7/8.x/10 — OS X 10.10/10.11

• CPU Intel o AMD dual-core

• 4 GB di RAM

• 4 GB di spazio libero su hard disk

• Risoluzione dello schermo di 1920 x 1080 (minimo: 1024 x 768)

• Hardware audio compatibile con OS

• Lettore DVD dual-layer

• Connessione internet necessaria per le operazioni di attivazione, 
configurazione dell’account e per la registrazione personale e del 
prodotto. Per completare il processo di attivazione potrebbero 
essere necessari dei download aggiuntivi.

Per ottenere informazioni sui sistemi raccomandati e sul supporto dei 
sistemi operativi futuri, fare riferimento alla sezione Support del nostro 
sito web all'indirizzo www.steinberg.net.
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Installare il programma

Il programma può essere installato in due modi: tramite lo Start Center 
o manualmente.

Lanciare l’installazione dallo Start Center

Dallo Start Center è possibile installare in maniera rapida e semplice il 
proprio programma e ottenere informazioni sui pacchetti di contenuti.

• Per quanto riguarda il software Steinberg fornito con un supporto 
di installazione, lo Start Center si avvia automaticamente non 
appena si inserisce il disco nel lettore DVD del computer, a 
condizione che la funzione di autorun sia attivata.

• Per quanto riguarda il software Steinberg acquistato tramite 
download da internet, lo Start Center si avvia quando si fa 
doppio-clic sul file scaricato.

PROCEDIMENTO

1. Nello Start Center, selezionare la lingua desiderata.

2. Fare clic su Installa.

3. Seguire le istruzioni a schermo.

Lanciare l’installazione manualmente

Se non si desidera installare il programma tramite lo Start Center, è 
possibile farlo manualmente.

• Su sistemi Windows, fare doppio-clic sul file «Setup.exe» e seguire 
le istruzioni a schermo.

Quick_Start_Guide_EnDeFrItEsJa.book  Page 57  Tuesday, December 8, 2015  9:46 AM



Requisiti di sistema e installazione
Attivazione delle licenze

58

ITA
LIA

N
O

• Su sistemi Mac OS X, fare doppio-clic sul file WaveLab 
Elements 9.pkg e seguire le istruzioni a schermo.

Attivazione delle licenze

IMPORTANTE

Il processo da seguire per l’attivazione delle licenze è descritto nel 
dettaglio sul sito web di Steinberg. Per aprire la pagina corrispondente, 
seguire il link Attivazione e Registrazione nello Start Center.

WaveLab Elements fa uso di uno schema di protezione dalla copia su 
base software. Il cosiddetto Soft-eLicenser viene installato 
automaticamente insieme alla vostra versione di WaveLab Elements ed 
è possibile accedervi tramite l’applicazione eLicenser Control Center 
(installata anch’essa automaticamente con il prodotto).

Dopo l’installazione è necessario attivare il prodotto. Se avete 
acquistato WaveLab Elements in un negozio fisico, la confezione 
include un foglio chiamato «Essential Product License Information» 
contenente un codice di attivazione e la descrizione dettagliata del 
processo di attivazione.

Se invece avete acquistato la versione download di WaveLab 
Elements, avete ricevuto un’e-mail con il codice di attivazione e la 
descrizione del processo di attivazione.
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Registrazione del software

Registrate il vostro prodotto sul portale online MySteinberg riservato ai 
nostri clienti. Come utenti registrati, avrete diritto al supporto tecnico e 
potrete beneficiare di esclusive offerte come aggiornamenti, upgrade 
software e molto altro.

PREREQUISITI 

Assicurarsi di disporre di una connessione internet funzionante.

PROCEDIMENTO

1. Avviare il proprio software.

2. Selezionare Aiuto > Esegui adesso la registrazione.

Nel proprio browser internet si apre un form di registrazione online.

3. Seguire le istruzioni a schermo per registrarsi a MySteinberg.

Installazione dell’hardware

Installazione dell’hardware audio e dei rispettivi 
driver

PROCEDIMENTO

1. Installare la periferica audio e le relative apparecchiature hardware 
nel computer, come indicato nella relativa documentazione.

2. Installare il driver dell’hardware audio.

Il driver è quel software che consente ad un programma di comunicare 
con i dispositivi hardware. In questo caso, il driver permette a 
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WaveLab Elements di utilizzare l’hardware audio. A seconda del sistema 
operativo installato sul proprio computer, possono essere utilizzati diversi 
tipi di driver.

Driver ASIO dedicati

Spesso le apparecchiature audio professionali dispongono di un driver 
ASIO dedicato che rende possibile una comunicazione diretta tra 
WaveLab Elements e l’hardware audio. Di conseguenza, le schede 
audio con driver ASIO specifici sono in grado di offrire un livello molto 
ridotto di latenza (ritardo ingresso-uscita), caratteristica di 
fondamentale importanza quando si esegue il monitoraggio dell’audio 
in WaveLab Elements o si usano i VST Instrument. Il driver ASIO può 
inoltre fornire un supporto speciale per ingressi e uscite multipli, per le 
assegnazioni, per la sincronizzazione, ecc.

I driver ASIO vengono forniti direttamente da parte dei produttori delle 
periferiche audio. Si consiglia di visitare periodicamente il sito web dei 
relativi produttori per scaricare le ultime versioni dei driver.

IMPORTANTE

Se l’hardware audio viene fornito con un driver ASIO specifico si 
raccomanda di usarlo.

Driver Mac OS X (solo Mac)

Se si usa un computer Macintosh, assicurarsi di utilizzare per 
l’hardware audio i driver Mac OS X più recenti. Per installare i driver 
seguire le istruzioni del costruttore.
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Schede audio

WaveLab Elements funziona con qualsiasi scheda audio multimediale. 
Tuttavia, la qualità audio può variare in maniera sostanziale da una 
scheda all’altra.

Per un utilizzo professionale di WaveLab Elements consigliamo di 
dotarsi di una scheda di elevata qualità e prestazioni. Tuttavia, se si 
utilizza WaveLab Elements per l’editing di file da utilizzare con altre 
apparecchiature hardware, come ad esempio dei sistemi di 
registrazione basati su hard disk e dotati di propri convertitori audio, 
qualsiasi perdita di qualità audio che si dovesse verificare durante 
l’ascolto dei file in WaveLab Elements, dovuta a carenze della scheda 
audio, non ha effetto sui file audio finali.

Per un utilizzo professionale consigliamo di dotarvi di una scheda in 
grado di riprodurre i file a una risoluzione di 24-bit.

Testare l’hardware audio

Per assicurarsi che la periferica audio funzioni correttamente, occorre 
eseguire i seguenti test.

• Utilizzare il software fornito con la periferica audio per assicurarsi 
di riuscire a registrare e riprodurre l’audio senza problemi.

• Se si accede all’hardware audio tramite un driver standard del 
sistema operativo, provare a riprodurre l’audio con l’applicazione 
audio standard del computer (ad esempio, Windows Media Player 
o Apple iTunes).
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Installare un’interfaccia MIDI o una tastiera MIDI 
USB

Sebbene molte tastiere MIDI USB e interfacce MIDI siano plug&play, 
potrebbe essere necessario installare un driver dedicato. Si prega di 
seguire le procedure di installazione descritte nella documentazione 
fornita con la periferica.

NOTA

Si raccomanda di consultare il sito web del costruttore per verificare la 
disponibilità di driver più aggiornati.

Configurare il proprio sistema

Selezionare il driver per la propria periferica audio

PREREQUISITI 

Prima di poter configurare le assegnazioni dei segnali audio e iniziare la 
registrazione, è necessario assicurarsi che sia selezionato il driver ASIO 
corretto.

PROCEDIMENTO

1. Selezionare File > Preferenze > Connessioni Audio VST.

2. Nel menu Periferica audio, selezionare il driver che si intende 
utilizzare.

LINK CORRELATI
“Installazione dell’hardware” a pag. 59
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Configurare le Connessioni Audio VST

La scheda Connessioni Audio VST consente di configurare 
l’assegnazione dei segnali d’ingresso e uscita tra WaveLab Elements e 
le proprie periferiche hardware audio. In base al driver selezionato, il 
processo di configurazione può variare.

PREREQUISITI 

Selezionare il driver per la propria periferica audio.

PROCEDIMENTO

1. Selezionare File > Preferenze > Connessioni Audio VST.

2. Aprire la sezione Riproduzione, quindi selezionare e assegnare un 
nome alle porte audio utilizzate per la riproduzione.

3. Aprire la sezione Registrazione, quindi selezionare e assegnare 
un nome alle porte audio utilizzate per la registrazione e per il 
monitoraggio in ingresso.

4. Se si sta utilizzando un driver ASIO, selezionare la scheda Plug-in 
ASIO, quindi selezionare le porte audio utilizzate dai plug-in ASIO.

5. Opzionale: se si sta utilizzando un driver ASIO, fare clic sul 
pulsante Pannello di controllo e regolare le impostazioni 
aggiuntive disponibili.

6. Fare clic su OK.
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Introducción

¡Bienvenido!

Felicidades y gracias por comprar WaveLab Elements 9, un entorno de 
edición y masterización básico que ofrece una selección de 
herramientas de calidad para pulir sus grabaciones de audio. Durante 
casi una década WaveLab Elements ha abastecido las necesidades de 
los productores, músicos, periodistas radiofónicos y podcasters 
incluyendo funciones innovadoras confeccionadas para esas áreas de 
trabajo.

Con el conjunto de herramientas más accesibles y extensas en la larga 
historia de WaveLab Elements, WaveLab Elements 9 reinventa el 
perfeccionamiento del audio una vez más. Los flujos de trabajo de 
edición y masterización jamás fueron tan creativos. La nueva interfaz de 
usuario de WaveLab Elements sigue el popular concepto de cinta, con 
múltiples funciones agrupadas lógicamente bajo una pestaña de cinta. 
De esta forma, las potentes funciones de edición y análisis de WaveLab 
Elements están a mano en cualquier momento y se encuentran justo 
encima de la forma de onda.

Una de las capacidades más creativas de WaveLab Elements 9 es 
MasterRig, una extensa suite de masterización derivada de la solución 
de masterización de calidad superior de WaveLab Pro 9. MasterRig en 
WaveLab Elements 9 le ofrece hasta 5 ranuras de plug-ins que se 
pueden cargar con novedosos y profesionales efectos tales como un 
EQ de 4 bandas, Compressor de 2 bandas, Limiter de 2 bandas, 
Saturator e Imager. Además de MasterRig, el nuevo y lujoso Resampler 
mejora la calidad al convertir material de audio a otras frecuencias de 
muestreo. WaveLab Elements 9 también está preparado para 
conectarse con otros productos de Steinberg, tales como Cubase y 
Nuendo, proporcionando así posibilidades para un intercambio fluido 
de material de audio con estas estaciones de trabajo de audio digital. 
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Por supuesto, el programa también contiene una selección de 
herramientas de análisis de audio de renombre, permitiéndole analizar 
y valorar su audio con herramientas tales como un Espectroscopio, un 
visor de espectro en 3D y un análisis global de WaveLab.

La suite de restauración Sonnox consistente en DeBuzzer, DeNoiser y 
DeClicker le permite la eliminación de ruidos molestos y una 
restauración precisa y efectiva de grabaciones de audio deterioradas.

Completado con un canal master rediseñado, un nuevo sistema de 
anclaje de ventanas así como muchas más mejoras, WaveLab 
Elements 9 aumenta dramáticamente la calidad de su material de audio 
y establece nuevos estándares en la edición y la masterización creativa.

No olvide registrarse en MySteinberg y así tener acceso a ofertas de 
soporte en línea y servicios exclusivos adicionales. También estaríamos 
encantados si pudiéramos darle la bienvenida como miembro de la 
comunidad WaveLab. El foro en línea de WaveLab puede encontrarse 
a través de www.steinberg.net/forum.

¡Nos vemos!

Su Equipo Steinberg WaveLab

Acerca de la Documentación y la Ayuda

• Para abrir la ayuda en el programa, seleccione Ayuda > Contenidos.

• Para abrir el Manual de Operaciones en formato PDF, seleccione 
Ayuda > Documentación PDF, o navegue hasta la carpeta de 
instalación. Los documentos PDF se encuentran en la carpeta 
Documentation.

NOTA

Para leer los documentos pdf, una aplicación de lectura pdf adecuada 
debe estar instalada en su ordenador.
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Guía de Inicio Rápido

Es el documento que usted está leyendo. Cubre las siguientes áreas 
sin entrar en detalles:

• Requisitos del sistema, procedimiento de instalación, y activación 
de licencia.

• Configurar el sistema.

Manual de Operaciones

El Manual de Operaciones es la documentación de referencia principal 
de WaveLab Elements, con descripciones detalladas de operaciones, 
parámetros, funciones y técnicas.

Comandos de teclado

Muchos de los comandos de teclado usan teclas modificadoras, 
algunas de ellas son diferentes dependiendo del sistema operativo.

Por ejemplo, el comando de teclado por defecto para Deshacer es 
[Ctrl]-[Z] en sistemas Windows y [Comando]-[Z] en sistemas Mac OS 
X. Cuando se describen en este manual los comandos de teclado con 
teclas modificadoras, se muestran con la tecla modificadora de 
Windows primero, de la siguiente manera:

• [Tecla modificadora de Win]/[Tecla modificadora de Mac]-[tecla]

[Ctrl]/[Comando]-[Z] significa: pulse [Ctrl] en Windows o [Comando] 
en Mac OS X, luego pulse [Z].

Análogamente, [Alt]/[Opción]-[X] significa: pulse [Alt] en Windows u 
[Opción] en Mac OS X, luego pulse [X].
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Convenciones

En nuestra documentación usamos elementos tipográficos y marcas 
para estructurar la información.

Cómo puede contactar con nosotros

En el menú Ayuda encontrará elementos que enlazan a información 
adicional.

El menú contiene enlaces a varias páginas web de Steinberg. 
Seleccionar un elemento del menú abre automáticamente su 
navegador web y carga la página. En estas páginas puede encontrar 
información de soporte y compatibilidad, respuestas a preguntas 
frecuentes, información acerca de actualizaciones y otros productos de 
Steinberg, etc. Es necesario tener conexión a internet.
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Requisitos del sistema e 
instalación

Requisitos de sistema

Windows 7/8.x/10 — OS X 10.10/10.11

• CPU de doble núcleo Intel o AMD

• 4 GB de RAM

• 4 GB de espacio libre en el disco duro

• Resolución de pantalla de 1920 x 1080 (mínimo: 1024 x 768)

• Tarjeta de sonido compatible con su sistema operativo

• Unidad DVD ROM de doble capa

• Se requiere conexión a internet para la activación, configuración 
de la cuenta, y registro personal y del producto. Es posible que se 
necesiten descargas adicionales para la instalación.

Para recomendaciones de sistemas y soporte para futuros sistemas 
operativos, por favor vea la sección Soporte en nuestro sitio web 
www.steinberg.net.
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Instalar el programa

Tiene dos posibilidades para instalar su programa, a través de la 
aplicación Start Center o manualmente.

Arrancar la instalación a través del Start Center

Desde la aplicación Start Center puede instalar su programa e 
informarse sobre los contenidos del paquete.

• En los programas de Steinberg distribuidos con un medio de 
instalación, el Start Center arranca automáticamente al insertar el 
disco en su unidad de DVD del ordenador, siempre que el 
autoarranque esté activado.

• En los programas de Steinberg descargados de internet, el Start 
Center arranca cuando hace doble clic sobre el archivo 
descargado.

PROCEDIMIENTO

1. En el Start Center, seleccione su idioma.

2. Haga clic en Instalar.

3. Siga las instrucciones en la pantalla.

Arrancar la instalación manualmente

Si no desea instalar el programa a través del Start Center, puede 
instalarlo manualmente.

• En sistemas Windows, haga doble clic en el archivo «Setup.exe» y 
siga las instrucciones en la pantalla.
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• En sistemas Mac OS X, haga doble clic en el archivo 
WaveLab Elements 9.pkg y siga las instrucciones en la 
pantalla.

Activar su licencia

IMPORTANTE

El proceso de activación de licencia se describe con detalle en el sitio 
web de Steinberg. Para abrir la página correspondiente, siga el enlace 
Activación y Registro del Start Center.

WaveLab Elements usa un esquema de protección anticopia basado 
en software. El llamado Soft-eLicenser se instala automáticamente con 
su versión de WaveLab Elements. Se puede acceder a él a través de la 
aplicación eLicenser Control Center que se instala automáticamente 
con el producto.

Después de la instalación, es necesario activar su producto. Si compró 
WaveLab Elements en una tienda, el paquete del producto contiene la 
hoja «Essential Product License Information» que contiene el código de 
activación y describe el proceso al detalle.

Si compró la versión descargable de WaveLab Elements, recibió un 
correo electrónico con el código de activación y una descripción del 
proceso de activación.
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Registrar su programa

Registre su producto en el portal online del cliente MySteinberg. Como 
usuario registrado tiene derecho a soporte técnico, y acceso a ofertas 
exclusivas tales como actualizaciones y mejoras de programas, y más.

PREREQUISITO 

Asegúrese de que su conexión a internet esté activa.

PROCEDIMIENTO

1. Inicie su software.

2. Seleccione Ayuda > Registrarse ahora.

Se abre un formulario online de registro en su navegador web.

3. Siga las instrucciones en la pantalla para registrarse en MySteinberg.

Instalación del hardware

Instalar el hardware de audio y sus controladores

PROCEDIMIENTO

1. Instale la tarjeta de audio y el hardware relacionado en el 
ordenador, tal como se describe en la documentación de la tarjeta.

2. Instale el controlador para la tarjeta de audio.

Un controlador es un componente de software que permite a un programa 
comunicarse con un determinado hardware. En este caso, el controlador 
permite que WaveLab Elements utilice la tarjeta de sonido. Dependiendo 
del sistema operativo de su ordenador, hay diferentes tipos de 
controladores que se pueden usar.
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Controladores ASIO dedicados

Las tarjetas de audio profesionales vienen a menudo con un 
controlador específico ASIO diseñado especialmente para el 
dispositivo. Esto le permite la comunicación directa entre 
WaveLab Elements y la tarjeta de sonido. Como resultado, los 
dispositivos con controladores ASIO específicos pueden proporcionar 
una latencia menor (retardo de entrada-salida), lo que es fundamental 
al monitorizar la señal a través de WaveLab Elements o al usar 
instrumentos VST. El controlador ASIO también puede ofrecer un 
soporte especial para múltiples entradas y salidas, enrutamiento, 
sincronización, etc.

Los controladores ASIO los distribuyen los fabricantes de tarjetas de 
audio. Asegúrese de comprobar el sitio web del fabricante para 
obtener las versiones más recientes del controlador.

IMPORTANTE

Si su hardware de audio viene con un controlador ASIO específico, le 
recomendamos que lo utilice.

Controladores Mac OS X (solo Mac)

Si está usando un ordenador Macintosh, asegúrese de que está 
usando la última versión de los controladores Mac OS X con su tarjeta 
de audio. Siga las instrucciones del fabricante para instalar el 
controlador.
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Tarjetas de sonido

WaveLab Elements funciona con cualquier tarjeta de sonido 
multimedia compatible con ordenadores. Sin embargo, la calidad del 
sonido varía dramáticamente entre tarjetas.

Para un uso profesional de WaveLab Elements le recomendamos que 
obtenga una tarjeta con las mejores especificaciones posibles. Sin 
embargo, si usa WaveLab Elements para editar archivos para usar con 
otro hardware, tal como un sistema de grabación basado en disco duro 
que use sus propios conversores de audio, cualquier pérdida en la 
calidad de audio que pueda experimentar al escuchar los archivos en 
WaveLab Elements, debido a deficiencias en la tarjeta de sonido, no 
afectan a los archivos de audio finales.

Para el uso profesional le recomendamos que obtenga una tarjeta 
capaz de reproducir archivos a una resolución de 24-bits.

Probar la tarjeta de audio

Para asegurarse de que el dispositivo de audio funciona 
perfectamente, realice las siguientes pruebas.

• Utilice cualquier software incluido junto con la tarjeta para asegurarse 
de que es posible grabar y reproducir audio sin problemas.

• Si el acceso a la tarjeta se realiza a través de un controlador 
estándar del sistema operativo, intente reproducir la señal de 
audio usando la aplicación de sonido estándar del sistema 
operativo, Windows Media Player o Apple iTunes, por ejemplo.
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Instalar una interfaz MIDI o un teclado MIDI USB

Aunque muchos teclados MIDI USB e interfaces MIDI son dispositivos 
plug&play, puede tener que instalar un controlador del dispositivo 
dedicado. Siga el procedimiento de instalación descrito en la 
documentación que vino con su dispositivo.

NOTA

También debería comprobar el sitio web del fabricante para ver si hay 
actualizaciones más recientes de los controladores.

Configurar el sistema

Seleccionar el controlador para su tarjeta de audio

PREREQUISITO 

Antes de poder configurar el enrutamiento de sus señales de audio y 
comenzar a grabar, es necesario que se asegure de que está 
seleccionado el controlador ASIO correcto.

PROCEDIMIENTO

1. Seleccione Archivo > Preferencias > Conexiones de Audio 
VST.

2. En el menú Dispositivo de audio, seleccione el controlador que 
quiera usar.

VÍNCULOS RELACIONADOS
“Instalación del hardware” en la página 74
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Configurar las conexiones de audio VST

La pestaña Conexiones de Audio VST le permite configurar el 
enrutamiento de las señales de entrada y de salida entre 
WaveLab Elements y su tarjeta de sonido. Dependiendo del 
controlador seleccionado, el proceso de configuración puede ser 
diferente.

PREREQUISITO 

Seleccione el controlador de su tarjeta de sonido.

PROCEDIMIENTO

1. Seleccione Archivo > Preferencias > Conexiones de Audio 
VST.

2. Seleccione la pestaña Reproducción, y seleccione y nombre los 
puertos de audio usados para la reproducción.

3. Seleccione la pestaña Grabación, y seleccione y nombre los 
puertos de audio usados para la grabación y monitorización de 
entrada.

4. Si está usando un controlador ASIO, seleccione la pestaña 
Plug-ins ASIO, y seleccione los puertos de audio usados por los 
plug-ins ASIO.

5. Opcional: si está usando un controlador ASIO, haga clic en el 
botón Panel de control y haga ajustes adicionales.

6. Haga clic en Aceptar.
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はじめに

WaveLab の世界へようこそ
このたびは、Steinberg 社の基本のオーディオ編集/マスタリングソ 
フトウェア Wavelab Elements 9 をご購入いただきましてありがと    
うございます。このソフトウェアには、オーディオ素材の品質を向
上させるためのツールセットが含まれています。10 年近くの間、 
WaveLab Elements は各分野の用途に適した革新的な機能を搭載す  
ることで、プロデューサー、ミュージシャン、ラジオジャーナリス
ト、およびポッドキャスターのニーズを満たしてきました。

WaveLab Elements の長い歴史の中で最も包括的で使いやすい機能  
を備える WaveLab Elements 9 は、オーディオ編集を再び一から考    
え直しました。マスタリングと編集のワークフローはこれまでにな
くクリエイティブになります。WaveLab Elements の新しいユー  
ザーインターフェースには人気のあるリボンコンセプトを採用し、
各リボンタブにはさまざまな機能が論理的にグループ化されてい
ます。これにより、波形のすぐ上に配置された WaveLab Elements の   
パワフルな編集、および分析機能をいつでもすぐに使用できます。

WaveLab Elements 9 の最もクリエイティブな機能の 1 つが MasterRig      
です。MasterRig は、ハイエンドのマスタリングソリューションであ 
る WaveLab Pro 9 から派生した包括的なマスタリングスイートで    
す。WaveLab Elements 9 の MasterRig では最大 5 つのプラグインス       
ロットを使用でき、各スロットには 4 バンド EQ、2 バンドコンプ    
レッサー、2 バンドリミッター、サチュレーター、イメージャーなど、 
プロフェッショナル向けのまったく新しいエフェクトを読み込む
ことができます。 MasterRig に加え、新しい高性能 Resampler では、    

Quick_Start_Guide_EnDeFrItEsJa.book  Page 82  Tuesday, December 8, 2015  9:46 AM



はじめに
WaveLab の世界へようこそ

83

日
本
語

オーディオ素材を別のサンプリングレートに変換する際の品質が
向上しています。また、WaveLab Elements 9 は Cubase や Nuendo      
といった他の Steinberg 製品と連携できるように、人気のあるこれ  
らのデジタルオーディオワークステーションとシームレスにオー
ディオ素材をやり取りできるようになっています。もちろん、プロ
グラムには評価の高いさまざまなオーディオ分析ツールも含まれ
ており、スペクトロスコープ、3D スペクトラム表示、全般情報の検 
出などのツールを使用して、オーディオ素材を分析および評価でき
ます。

DeBuzzer、DeNoiser、および DeClicker で構成される Sonnox 社の復    
元プラグインスイートを使用すると、分散したノイズを除去し、状
態の悪いオーディオ録音を正確かつ効率的に復元できます。

さらに、再設計されたマスターチャンネルや新しいウィンドウドッ
キングシステムなど、一層強化された多くの機能によって、
WaveLab Elements 9 はオーディオ素材の質を大幅に向上し、クリ   
エイティブな編集およびマスタリングの新たなスタンダードを創
造します。

オンラインサポートや追加のスペシャルサービスを受けられるよ
う、MySteinberg に登録することをおすすめします。また、WaveLab 
オンラインフォーラムへの訪問をお待ちしています。WaveLab オ 
ンラインフォーラムは、www.steinberg.net/forum からアクセスで 
きます。

それでは WaveLab の世界をお楽しみください。
Steinberg WaveLab チーム一同
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マニュアルおよびヘルプについて
• アプリケーション内でヘルプを開くには、「ヘルプ (Help)」>

「ヘルプコンテンツ (Contents)」を選択します。
• PDF 形式のオペレーションマニュアルを開くには、「ヘルプ 

(Help)」>「PDF マニュアル (PDF Documentation)」を選択
するか、WaveLab のインストールフォルダーを参照します。
PDF マニュアルは、Documentation フォルダーにあります。

補足
PDF マニュアルを読むには、コンピューターに Adobe Reader がイ    
ンストールされている必要があります。

クイックスタートガイド
このマニュアルです。以下の内容の概要を説明しています。
• システム要件、インストール手順、およびライセンスアクティ

ベーション

• システムの設定

オペレーションマニュアル
WaveLab Elements のメインのマニュアルです。操作方法、パラメー  
ター、機能、およびテクニックを詳しく説明します。
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キーボードショートカット
初期設定のキーボードショートカットの多くは修飾キーを使用し
ますが、修飾キーの一部はオペレーティングシステムによって異な
ります。

たとえば、「取り消し操作」のデフォルトキーボードショートカッ
トは Windows の場合、[Ctrl]+[Z] ですが、Mac では [command]+[Z]     
です ([command] はアップルマークのついたキー)。本書では、修飾  
キーを伴うキーボードショートカットを記述する場合、まず
Windows の修飾キーを挙げ、次のように記載します。

• [Windows 修飾キー]/[Mac 修飾キー]+[ キー]

[Ctrl]/[Command]+[Z]: Windows では [Ctrl]、Mac では [Command]     
を押しながら [Z] を押します。

[Alt]/[Option]+[X]: Windows では [Alt]、Mac では [Option] を押しな      
がら [X] を押します。

表記規則
本書では、表記上の要素およびマークアップを使用して説明してい
ます。
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Steinberg 社の Web サイトへのアクセス
方法
「ヘルプ (Help)」メニューから追加情報にアクセスできます。
このメニューには、Steinberg 社のさまざまな Web サイトへのリン   
クが表示されます。いずれかのリンクを選択すると、Web ブラウ 
ザーが自動的に起動し、該当のページが開きます。製品に関するサ
ポートや互換性の情報、FAQ、更新情報、他の Steinberg 製品の情報  
などにアクセスできます。Web サイトにアクセスするには、イン 
ターネットに接続されている必要があります。
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システム要件とインストール

最小システム要件
Windows 7/8.x/10 ̶ OS X 10.10/10.11
• デュアルコア CPU (Intel/AMD)

• 4 GB の RAM
• 4 GB の HD 空き容量

• 1920 x 1080 のディスプレイ解像度 ( 最小 : 1024 x 768)
• OS 互換のオーディオデバイス

• デュアルレイヤー対応 DVD-ROM ドライブ

• インターネット接続環境 ( アクティベーション、アカウント
設定、およびユーザー/製品登録用 )。インストール時に、追加
のダウンロードが必要になる場合があります。

推奨システムおよび今後のオペレーティングシステムのサポート
については、Steinberg 社の Web サイト (www.steinberg.net) の「サ     
ポート (Support)」セクションを参照してください。

プログラムのインストール
プログラムをインストールするには、Start Center アプリケーショ  
ンを使用するか手動でインストールするかの 2 つの方法がありま  
す。
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Start Center を使用したインストール

Start Center アプリケーションを使用すると、簡単にプログラムを  
インストールしたり、パッケージ内容を確認したりできます。
• インストールメディアで提供される Steinberg ソフトウェア

については、コンピューターの自動実行機能が有効になって
いれば、コンピューターの DVD ドライブにディスクを挿入す
るとすぐに Start Center が自動的に起動します。

• インターネットからダウンロードした Steinberg ソフトウェ
アについては、ダウンロードしたファイルをダブルクリック
すると Start Center が起動します。

手順
1. Start Center で、言語を選択します。
2. 「インストール (Install)」をクリックします。
3. 画面に表示される指示に従って操作します。

手動でのインストール

プログラムのインストールに、Start Center を使用しない場合、手動  
でインストールできます。
• Windows システムの場合は、「Setup.exe」ファイルをダブル

クリックし、画面に表示される指示に従って操作します。

• Mac システムの場合は、WaveLab Elements 9.pkg ファイルを
ダブルクリックし、画面に表示される指示に従って操作しま
す。

Quick_Start_Guide_EnDeFrItEsJa.book  Page 88  Tuesday, December 8, 2015  9:46 AM
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ライセンスのアクティベート

89

日
本
語

ライセンスのアクティベート

重要
ライセンスのアクティベート手順については、Steinberg 社 
の Web サイトを参照してください。該当ページを開くには、  
Start Center で「アクティベーションと登録 (Activation &    
Registration)」リンクをクリックします。

WaveLab Elements には、ソフトウェアベースのコピー防止機構が  
あります。Soft-eLicenser と呼ばれるこの機構は、ご利用バージョン 
の WaveLab のインストール時に自動的にインストールされます。  
Soft-eLicenser は、製品と一緒に自動的にインストールされる 
eLicenser Control Center アプリケーションからアクセスできま   
す。

製品をインストールしたら、アクティベートする必要があります。
Steinberg 社製品を取り扱う販売店で WaveLab Elements を購入した    
場合、製品パッケージにアクティベーションコードとアクティベー
ト手順の詳細が記載された「Essential Product License Information」   
シートが同梱されています。

ダウンロード版の WaveLab Elements を購入した場合は、アクティ   
ベーションコードとアクティベート手順が記載された電子メール
が送信されます。
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ソフトウェアの登録

90

日
本
語

ソフトウェアの登録
MySteinberg オンラインカスタマーポータルに製品を登録します。 
製品を登録すると、テクニカルサポートを利用したり、ソフトウェ
アの更新やアップグレードなどの限定キャンペーンを利用したり
できます。

前提 

登録には、インターネット接続が必要です。

手順
1. ソフトウェアを起動します。
2. 「ヘルプ (Help)」>「すぐに登録 (Register Now)」を選択しま
す。
Web ブラウザーでオンライン登録フォームが開きます。

3. 画面に表示される指示に従って MySteinberg に登録します。
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ハードウェアの取り付け

91

日
本
語

ハードウェアの取り付け

オーディオデバイスの取り付けとドライバーの
インストール

手順
1. 各ハードウェアのマニュアルを参照して、オーディオデバイス
と関連機器をコンピューターに取り付けます。

2. オーディオデバイスのドライバーをインストールします。
ドライバーは、プログラムが特定のハードウェアと通信するの
に必要なソフトウェアです。WaveLab Elements では、オーディ
オデバイスを使用するのにドライバーが必要です。ご使用のオ
ペレーティングシステムによって、使用できるドライバーの種
類が異なります。ハードウェアによっては、ドライバーをイン
ストールしてからコンピューターに接続するものもあります。
詳しくは、各ハードウェアのマニュアルをご参照ください。

専用の ASIO ドライバー

プロ用オーディオデバイスの多くには、デバイス専用に作成された
ASIO ドライバーが付属しています。このドライバーによって、 
WaveLab Elements がオーディオデバイスと直接通信できます。そ  
のため、専用の ASIO ドライバーを使用するデバイスは、レイテン  
シー (入出力の遅れ) が低くなります。これは、WaveLab Elements で    
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日
本
語

オーディオをモニタリングしたり、VST インストゥルメントを使用 
したりするのに非常に重要です。ASIO ドライバーは、複数の入出 
力、ルーティング、同期などの特別なサポートを提供する場合もあ
ります。

ASIO ドライバーは、オーディオデバイスのメーカーが提供します。 
メーカーの Web サイトでドライバーの最新バージョンを確認して  
ください。

重要
オーディオデバイスに専用の ASIO ドライバーが付属してい  
る場合、それを使用してください。

Mac OS X ドライバー (Mac のみ )

Mac コンピューターを使用している場合、オーディオデバイス用の 
最新の Mac OS X ドライバーを使用していることを確認してくださ    
い。ドライバーのインストール方法については、メーカーのマニュ
アルを参照してください。

サウンドカード

WaveLab Elements は、マルチメディアコンピューターに互換性の  
あるサウンドカードで動作します。ただし、オーディオ品質は、カー
ドによって大幅に異なります。
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93

日
本
語

プロフェッショナルな用途に WaveLab Elements を使用するには、で   
きるだけ高性能のサウンドカードを使用することをおすすめします。
ただし、独自のオーディオコンバーターを使用するハードディスク
ベースの録音システムなど、他のハードウェアと WaveLab Elements  
を使用してファイルを編集する場合に WaveLab Elements でファイ   
ルを聴いたとき、サウンドカードの性能不足によってオーディオ品質
が低下しても、最終的なオーディオファイルの品質には影響しま
せん。
プロフェッショナルな用途には、24 ビット以上の解像度でファイ 
ルを再生できるカードを使用することをおすすめします。

オーディオデバイスのテスト

オーディオデバイスが適切に動作しているかどうかを確認するに
は、以下のテストを行ないます。

• デバイスに付属するソフトウェアを使用して、オーディオの
録音および再生が問題なくできることを確認します。

• オペレーティングシステム標準のドライバーでデバイスにア
クセスしている場合、Windows Media Player や Apple iTunes 
などのコンピューターの標準オーディオアプリケーションを
使用して、オーディオを再生してみます。
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ハードウェアの取り付け

94

日
本
語

MIDI インターフェースまたは USB MIDI キー
ボードの接続

多くの USB MIDI キーボードや MIDI インターフェースはプラグア     
ンドプレイに対応していますが、専用のデバイスドライバーのイン
ストールが必要な場合があります。インストール手順については、
そのデバイスのマニュアルを参照してください。

補足
メーカーの Web サイトでドライバーの最新バージョンを確認して  
ください。
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システム要件とインストール
システムの設定

95

日
本
語

システムの設定

オーディオデバイス用ドライバーの選択

前提 

オーディオ信号のルーティングを設定して録音を開始する前に、正
しい ASIO ドライバーが選択されていることを確認する必要があり  
ます。

手順
1. 「ファイル (File)」>「ユーザー設定 (Preferences)」>「VST 
オーディオの接続 (VST Audio Connections)」を選択しま
す。

2. 「オーディオデバイス (Audio Device)」メニューで、使用す
るドライバーを選択します。

関連リンク
91 ページの「ハードウェアの取り付け」
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96

日
本
語

VST オーディオ接続の設定

「VST オーディオの接続 (VST Audio Connections)」タブでは、    
WaveLab Elements とオーディオデバイス間の入出力信号のルー  
ティングを設定できます。選択したドライバーによって、設定手順
が異なる場合があります。

前提 

オーディオデバイス用ドライバーを選択します。

手順
1. 「ファイル (File)」>「ユーザー設定 (Preferences)」>「VST 
オーディオの接続 (VST Audio Connections)」を選択しま
す。

2. 「再生 (Playback)」タブを選択し、再生に使用するオーディオ
ポートを選択して名前を付けます。

3. 「録音 (Recording)」タブを選択し、録音および入力モニタリン
グに使用するオーディオポートを選択して名前を付けます。

4. ASIO ドライバーを使用している場合、「ASIO プラグイン 
(ASIO Plug-ins)」タブを選択し、ASIO プラグインに使用する
オーディオポートを選択します。

5. ASIO ドライバーを使用している場合は、「コントロールパネ
ル (Control Panel)」ボタンをクリックして、その他の設定を行
ないます。

6. 「OK」をクリックします。
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日
本
語

ユーザーサポート

ユーザーサポートについて 
( 日本国内 / 株式会社ヤマハミュージック
ジャパン )
ヤマハが輸入・販売した製品をご購入され、ユーザー登録を完了さ
れたお客様に限り、株式会社ヤマハミュージックジャパンでのお問
い合わせ対応やバージョンアップ / アップグレードなどのサポー  
ト・サービスを提供しております。
日本国内でのサポート・サービスについての詳細は Steinberg 日本  
語サイトをご参照ください。
http://japan.steinberg.net/support

※ サポート・サービスの内容は予告なく変更する場合がございま
す。
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ユーザーサポート
ユーザー登録について (MySteinberg)

98

日
本
語

ユーザー登録について (MySteinberg)
Steinberg 日本語サイトの「MySteinberg」にて、アカウントの作成、 
および製品登録を行ってください。

ご登録の際は、サポート情報のご案内や、窓口へのお問い合わせに
必要なため、以下の項目にチェックを入れることをおすすめしま
す。

• 最新情報を定期的にお届けする Steinberg eNews のご購読

• ヤマハミュージックジャパンが、MySteinberg に登録された
情報を共有することへの同意

また、ユーザーサポートをスムーズに行うために、ご住所、お名前、
電話番号などもご登録ください。

お客様お問い合わせ窓口
スタインバーグ・コンピューターミュージック・インフォメーショ
ンセンター
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99

日
本
語

お問い合わせの前に

• マニュアルをお読みください。また、窓口からの回答をマニュ
アルの該当箇所のご案内のみとすることがございます。

• Steinberg サポートページに、「Q&A- よくあるお問い合わせ」
をご用意しております。Q&A には過去のお問い合わせとその
解決方法を掲載しております。また、窓口からの回答を Q&A 
記事のご案内のみとすることがございます。

• 最新のアップデーターを適用することで問題が解決する場合
がございます。Steinberg サポートページよりダウンロード
の項目をご確認ください。

窓口でのご案内について

• マニュアルや Q&A などで解決しない場合、スタインバーグ・
コンピューターミュージック・インフォメーションセンター
にてご質問を承っております。

• ヤマハが輸入・販売した製品、また、そのユーザー登録を完了
されたお客様に限ります。

• 当社が本来意図した使用方法における基本操作をご案内いた
します。ノウハウ、テクニック、音楽理論、コンピューターや製
品に関連する一般知識はご案内いたしかねます。

• ユーザーサポートサービスは日本国内においてのみ有効で
す。

• 日本語でのサポートのみを承っております。
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100

日
本
語

• テクニカルサポートはサポート期間内の製品に限らせていた
だきます。

• 製品改善提案、新技術、新製品、アイデアについては承ってお
りません。

• 営業日や営業時間、サポート・サービスの内容は予告なく変更
する場合がございます。

お問い合わせの際にご用意いただく情報

お問い合わせの際は以下の内容をお知らせください。お客様からの
情報が不足している場合は、お返事できない場合があります。

• 製品名 ( ソフトウェアの場合はバージョン番号 )
• MySteinberg ユーザーネーム、ご住所、お名前、電話番号

• ご使用のコンピューターのメーカー名と OS の種類
• 操作の手順やそれによる結果と状態、入力されたデータの内

容の詳細
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ユーザーサポート
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101

日
本
語

電話でのお問い合わせ

ナビダイヤル ( 全国共通番号 ) 0570-016-808

※ ナビダイヤル＝全国どこからでも市内通話料金でおかけいただ 
けます。 
(IP 電話の場合　TEL 053-460-5270) 

受付時間 : 月曜～金曜 11:00 ～ 19:00

( 休日・祝祭日およびセンターの休業日を除く )

• お客様とのお電話は、お問合せに対する回答、ご要望に対する
対応および応対品質向上のために全ての通話内容を録音して
おります。

• お客様とのお電話が予期せぬ障害などで途中切断してしまっ
た時のため、または応対に正確を期すために、お電話番号の通
知をお願いしております。発信番号を非通知に設定されてい
る場合は、はじめに ”186” をダイヤルしてから、問合せ先電話
番号におかけいただきますようご協力をお願いいたします。
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102

日
本
語

メールでのお問い合わせ
ヤマハウェブサイトお問い合わせページ
http://jp.yamaha.com/support/music-production/ 

• 土日・祝日およびセンター指定休業日などの都合、およびお問
い合わせの混雑状況・件数により、回答までにお時間をいただ
く場合がございます。

• 期日指定での回答はいたしかねます。あらかじめご了承くだ
さい。
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